
Introduction

The only thing standing between you and your writing is

your word processor. Yeah, I know: It’s supposed to be

helpful. Well, it tries. Computers can do only so much.

But you, as a smart person, are capable of so much more.

I’m guessing that’s why you opened this book.

Welcome to Word 2016 For Dummies, which removes the

pain from using Microsoft’s latest, greatest, most

confusing word-processing software ever! This book is

your friendly, informative, and entertaining guide to the

routine of processing words that is Word 2016.

Be warned: I’m not out to make you love Word. This book

won’t make you enjoy the program. Use it, yes. Tolerate

it, of course. The only promise I’m offering is to ease the

pain that most people feel from using Microsoft Word.

Along the way, I kick Word in the butt, and I hope you

enjoy reading about it.

About This Book

I don’t intend for you to read this book from cover to

cover. It’s not a novel, and if it were, it would be a

political space opera with an antihero and a princess

fighting elected officials who are in cahoots with a

galactic urban renewal development corporation. The

ending would be extremely satisfying.

This book is a reference. Each chapter covers a specific

topic or task you can accomplish by using Word 2016.

Within each chapter, you find self-contained sections,

each of which describes how to perform a specific task or

get something done. Sample topics you encounter in this

book include



Moving a block

Checking your spelling

Saving your stuff!

Text-formatting techniques

Working with tables in Word

Plopping down a picture

Mail merge, ho!

I give you no keys to memorize, no secret codes, no

tricks, no presentations to sleep through, and no wall

charts. Instead, each section explains a topic as though

it’s the first thing you read in this book. Nothing is

assumed, and everything is cross-referenced. Technical

terms and topics, when they come up, are neatly shoved

to the side, where you can easily avoid reading them.

The idea here isn’t for you to master anything. This

book’s philosophy is to help you look it up, figure it out,

and get back to work.

How to Use This Book

You hold in your hands an active book. The topics

between this book's yellow-and-black covers are all

geared toward getting things done in Word 2016. All you

need to do is find the topic that interests you and then

read.

Word uses the mouse and keyboard to get things done,

but mostly the keyboard.

I use the word click to describe the action of clicking the

mouse’s main (left) button.

This is a keyboard shortcut: Ctrl+P. Press and hold down

the Ctrl (Control) key and type the letter P, just as you



would press Shift+P to create a capital P.

Sometimes, you must press more than two keys at the

same time, such as Ctrl+Shift+T. Press Ctrl and Shift

together and then press the T key. Release all three keys.

Commands in Word 2016 exist as command buttons on

the Ribbon interface. I may refer to the tab, the

command group, and then the button itself to help you

locate that command button.

Menu commands are listed like this: Table ⇒ Insert Table.

This direction tells you to click the Table command

button and then choose the Insert Table item from the

menu that appears.

 Some of Word’s key commands are kept on the

File screen. To access that screen, click the File tab on

the Ribbon. To return to your document, click the Back

button, found in the upper-left corner of the File screen

and shown in the margin. Or you can press the Esc key.

When I describe a message or something else you see

onscreen, it looks like this:

Why should I bother to love Evelyn when robots will

eventually destroy the human race?

If you need further help in operating your computer, I

can recommend my book PCs For Dummies, 13th Edition

(Wiley). It contains lots of useful information to

supplement what you find in this book.

Foolish Assumptions

Although this book was written with the beginner in

mind, I still make a few assumptions. Foremost, I assume

that you're a human being, though you might also be an



alien from another planet. If so, welcome to Earth. When

you conquer our planet, please do Idaho last. Thanks.

Another foolish assumption I make is that you use

Windows as the computer's operating system. It could be

Windows 7, Windows 8, or Windows 10. Windows 9 is not

covered in this book. Differences between Windows

versions are trivial as far as Word is considered, but do

keep in mind that this book isn’t about Windows.

Your word processor is Microsoft Word 2016. It is not

Microsoft Works. It is not an earlier version of Word. It is

not WordPerfect. It is not a version of Word that runs on

a Macintosh.

Throughout this book, I use the term Word to refer to the

Microsoft Word program. The program may also be

called Word 2016 or even Microsoft Office Word 2016.

It’s all Word as far as this book is concerned. Word 2016

is part of the Microsoft Office 2016 suite of programs.

This book doesn’t cover any other part of Microsoft

Office, though I mention Excel and Outlook wherever

they encroach on Word’s turf.

What’s Not Here

Word is one heck of a program. Covering the entire thing

would fill a book several thousand pages long. (I kid you

not.) My approach in this book is to cover as much basic

word processing as possible. For that reason, some

advanced features got pushed off the table of contents.

I give you some information about macros, though it’s

super slim. Covering macros without a technical

description is difficult. If the publisher ever lets me

increase this book’s size to more than 408 pages, I’d be

happy to add a macro chapter; the publisher’s address is



in this book’s front matter, in case you want to lobby on

my behalf.

Some of Word’s more esoteric features are touched on

lightly here. For example, I could spend about 70 pages

detailing what can be done with graphics in Word, but I

limit myself to only a dozen pages.

Finally, this book doesn't cover using Word to make a

blog post or create a web page or how to use Word as

your email program. Word does these things, but I

consider this a word-processing book rather than a

Word-does-everything book.

Icons Used in This Book

 This icon flags useful, helpful tips or shortcuts.

 This icon marks a friendly reminder to do

something.

 This icon marks a friendly reminder not to do

something.

 This icon alerts you to overly nerdy information

and technical discussions of the topic at hand. The

information is optional reading, but it may enhance

your reputation at cocktail parties if you repeat it.

Where to Go from Here



Start reading! Observe the table of contents and find

something that interests you. Or look up your puzzle in

the index.

Read! Write! Let your brilliance shine!

My email address is dgookin@wambooli.com. Yes, that’s

my real address. I reply to all email I receive, and you’ll

get a quick reply if you keep your question short and

specific to this book or to Word itself. Although I enjoy

saying “Hi,” I cannot answer technical support questions

or help you troubleshoot your computer. Thanks for

understanding.

You can also visit my web page for more information or

as a diversion: www.wambooli.com. This book’s specific

support page can be found at www.wambooli.com/help/word. I

place errata and updates on that page, as well as write

frequent blog posts with Word information, tips, and

tricks.

The publisher also maintains a support page, complete

with updates and such. You can visit their site here:

www.dummies.com/go/word2016fdupdates. This book’s online

cheat sheet can be located here:

www.dummies.com/cheatsheet/word2016. And the web extras

mentioned in each chapter's introduction are hidden on

this page: www.dummies.com/extras/word2016.

Enjoy this book. And enjoy Word. Or at least tolerate it.

mailto:dgookin@wambooli.com
http://www.wambooli.com/
http://www.wambooli.com/help/word
http://www.dummies.com/go/word2016fdupdates
http://www.dummies.com/cheatsheet/word2016
http://www.dummies.com/extras/word2016


Part I

Your Introduction to Word

 Visit www.dummies.com for great Dummies content

online.

http://www.dummies.com/


In this part …

 Learn how to start Word 2016 and decipher the Word

screen.

 Familiarize yourself with how to quit and minimize

Word 2016.

 Get to know the PC keyboard and the touchscreen.

 Learn how to read the status bar and discover secret

symbols representing special characters in your text.



Chapter 1

Hello, Word!

In This Chapter

 Starting Word

 Deciphering the Word screen

 Understanding the Ribbon

 Zooming in and out

 Quitting Word

 Minimizing Word

Life would be easier if you used a pencil to write text.

You could grab a copy of Pencils For Dummies and be on

your way. That book is far thinner than this one and has

more illustrations, which some people find enriching.

Your ambitions are most likely higher, which is why

you’ve chosen, or had the choice thrust upon you, to use

Microsoft Word as your text composition tool. That’s a

good decision, but Word remains a far, far more complex

tool for composing text than a wooden cylinder filled

with graphite.

Start Your Word Day

As computer software, Microsoft Word dwells in the

realm of Windows. To get work done in Word, you must

contend with the multitudinous ways available in

Windows to run the Word program. These methods can

vary from the obvious to the obnoxiously cryptic, so



instead I present you with the three most common ways

to start your Word day.

Before you can use Word, your computer must be on

and ready to work. So turn on your PC, laptop, or

tablet if it’s not already on and toasty. Log into

Windows.

Do not attempt to make toast in your computer.

 Ensure that you sport a proper posture as you

write. Your wrists should be even with your elbows.

Your head should tilt down only slightly, although it’s

best to look straight ahead. Keep your shoulders back

and relaxed. Have a minion gently massage your feet.

Starting Word the traditional way
Propriety demands that I show the traditional, boring

way to start Word. Let me be quick:

1. Press the Windows key on the keyboard.

The Windows key is adorned with the Windows logo

icon, which I won’t illustrate here because it’s

changed over the years. The key is nestled between

the Ctrl and Alt keys to the left of the spacebar. A

duplicate is found on the right side of the spacebar.

Use either key.

2. Look for Microsoft Word on the Start menu.

The item might be titled Word or Word 2016 or

something similar.

If you don’t find Word right away in Windows 10, click

the All Apps button to hunt it down. In Windows 7,

click the All Programs button.



Sometimes Word is found on a Microsoft Office or

Office 2016 submenu.

3. Click the Word icon or button to start the

program.

Watch in amazement as the program unfurls on the

screen.

Starting Word the best way
The best way to start Word, and the way I do it every day,

is to click the Word icon on the taskbar. Word starts

simply and quickly.

The issue, of course, is how to get the Word icon on the

taskbar. Follow these steps:

1. Find the Word icon on the Start button’s All

Programs menu.

See the preceding section, Steps 1 and 2.

2. Right-click the Word icon.

3. Choose the command Pin to Taskbar.

The Word icon is pinned (permanently added) to the

taskbar.

Starting Word in Windows 8 (for the

few who still use Windows 8)

One of the reasons Windows 8 was so aggressively unpopular was that it

eschewed the traditional Start button menu for a tile-based Start screen. If

you’re still burdened with Windows 8, or you run Windows 10 in Tablet mode,

start Word by pressing the Windows key on the keyboard and then clicking

the Word 2016 tile on the Start screen.

You can stick the Word icon to the taskbar, as described in this chapter: Click

the Word tile on the Start screen and then choose the command Pin to

Taskbar. (The Pin to Taskbar command is at the bottom of the screen.)



Opening a document to start Word
You use the Word program to create documents, which

are stored on your computer in much the same way as

people pile junk into boxes and store them in their

garages. To start Word, open a document. Follow these

steps:

1. Locate the document icon.

 Use your Windows kung fu to open the proper

folders and hunt down a Word document icon, similar

to what’s shown in the margin.

2. Double-click the icon.

This step is a standard Word operation: Double-click

an icon to open a program. In this case, opening a

Word document starts Word.

The document is opened and presented on the screen,

ready for whatever.

You use Word to create documents. They’re saved to

storage on your computer or in the cloud. Details are

offered in Chapter 8.

The document name is assigned when it’s originally

saved. Use the name to determine the document’s

contents — providing that it was properly named when

first saved.

Document icons are managed by Windows. If you need

to find a lost document, rename it, or organize your

documents into a folder, you use Windows, not Word.

Behold the Word Program



Like all programs in Windows, Word offers its visage in a

program window. It’s the place where you get your word-

processing work done.

Working the Word Start screen
After starting Word, the first thing you may see is

something called the Word Start screen, as shown in

Figure 1-1. It’s friendlier than that ominous empty page

that’s intimidated writers since the dawn of paper. (The

blank page comes later.)

Figure 1-1: The Word Start screen.

You can use the Start screen to open a previously opened

document, start a new document based on a template, or

start with a blank document.



Previously opened documents are listed on the left side

of the window, as illustrated in Figure 1-1. Word’s

templates are found under the heading Featured.

Templates you’ve created appear under the Personal

link. Click a template thumbnail to create a new

document based on that template.

To start on a blank document, click the Blank Document

template. Then you see the ominous empty page, which I

wrote about earlier.

Once you’ve made your choice, Word is ready for you to

start writing. Word is also equally content if you just

stare at the screen and await inspiration.

The Word Start screen doesn't appear if you start Word

by opening a document. See the earlier section,

“Opening a document to start Word.”

You can also disable the Start screen so that Word

starts with a blank document. See Chapter 33.

 The Word Start screen appears only when you

first start Word. It does not appear if you start a new

document while the Word program window is already

open.

Examining Word’s main screen
Writing is scary enough when you first see the blank

page. With a computer, that level of terror just isn’t good

enough. Therefore, Word festoons its program window

with all kinds of controls. I recommend that you refer to

Figure 1-2 to get an idea of some basic terms. Ignore

them at your peril.



Figure 1-2: Word's visage.

The details of how all the gizmos and whatnot in the

Word window work are covered throughout this book.

They give you more control over your document,

although the basic task of typing text is pretty

straightforward. See Chapter 2 to get started.

 To get the most from Word’s window, adjust the

window size: Use the mouse to drag the window’s

edges outwards. You can also click the window’s



Maximize button (refer to Figure 1-2) to have the

window fill the screen.

The largest portion of Word’s screen is used to

compose text. It's blank and white, just like a fresh

sheet of paper. If you choose to use a template to start

a new document, this area may contain some preset

text.

Working the Ribbon
An important part of Word’s interface is the Ribbon. It's

where a majority of Word’s commands dwell and where

settings are made. These items appear as buttons, input

boxes, and menus.

The Ribbon is divided into tabs, as shown in Figure 1-3.

Each tab holds separate groups. Within the groups, you

find the command buttons that carry out various word-

processing duties.

Figure 1-3: The Ribbon.

To use the Ribbon, first click a tab. Then locate the

command you need by scanning the group names, and

then hunting down the button. Click the button to

activate the command or to display a menu from which

you can choose a command.



Some items on the Ribbon let you input text or values,

or make other settings.

Galleries on the Ribbon display a smattering of tiles. To

see them all, click the Show Gallery button in the

lower-right corner of the gallery, as illustrated in Figure

1-3.

Use the dialog box launcher icon in the lower-right

corner of a group to open a dialog box relevant to the

group's function. Not every group features a dialog box

launcher.

The amazingly frustrating thing about the Ribbon is

that it can change. Some tabs may appear and

disappear, depending on what you're doing in Word.

 To ensure that you always see all the command

buttons, adjust the program’s window as wide as is

practical.

 Clicking the File tab replaces the contents of the

Word window with a screen full of commands and

other information. To return to the Word window, click

the Back button (shown in the margin) or press the Esc

key.

Showing and hiding the Ribbon
The good news is that you can hide the Ribbon if it

bothers you. That way you see more document and less

junk. The bad news is that you might accidentally hide

the Ribbon when you don’t want to.

To control the Ribbon, use the Ribbon Display Options

menu, located in the upper-right part of the Word



window and illustrated in Figure 1-3. Choose an item to

determine how to display the Ribbon. Your choices are

Auto-Hide Ribbon: The most annoying choice, the

Ribbon appears only when you hover the insertion

pointer near the top of the document.

Show Tabs: With this choice, only the Ribbon’s tabs

appear. Click a tab to summon the rest of the Ribbon.

Show Tabs and Commands: This option shows the

entire Ribbon — tabs and commands — as illustrated

in Figures 1-2 and 1-3.

To temporarily hide the Ribbon, click the Hide the

Ribbon button, labeled in Figure 1-3. To bring back the

Ribbon, click a tab and then at the spot where the Hide

the Ribbon button appears. Click the pushpin icon to

make the Ribbon stick.

 I recommend that you keep the Ribbon visible as

you discover the wonders of Word.

Changing the document view
Just to keep you on your toes, Word offers multiple ways

to view your document. The blank area where you write,

which should be full of text by now, can be altered to

present information in a different way. Why would you

want to do that? You don’t! But it helps to know the

different ways so that you can change them back.

The standard way to view a document is called Print

Layout view. It’s the view shown in this book and it’s how

Word normally starts. A virtual page appears on the

screen, with four sides and text in the middle. What you

see on the screen is pretty much what you’ll see in the



final results, whether printed or published as an

electronic document.

The other views are

Read Mode: Use this view to read a document like an

eBook. The Ribbon and pretty much the rest of Word is

hidden while in Read mode.

Web Layout: This view presents your document as a

web page. It’s available should you undertake the

dreadful possibility of using Word as a web page editor.

Outline: This mode helps you organize your thoughts,

as covered in Chapter 25.

Draft: The Draft view presents only basic text, not all

the formatting and fancy features such as graphics.

To switch between Read Mode, Print Layout, and Web

Layout views, click one of the View buttons, found in the

lower-right corner of the Word program window (refer to

Figure 1-2).

To get to Outline and Draft views, as well as to see all

View modes in one location, click the Views tab and

choose a command button from the Views group.

Making text larger or smaller
When the information in Word’s window just isn’t big

enough, don’t enlarge the font! Instead, whip out the

equivalent of a digital magnifying glass, the Zoom

command. It helps you enlarge or reduce your document,

making it easier to see or giving you the Big Picture look.

Several methods are available to zoom text in Word. The

most obvious is to use the Zoom control found in the

lower-right corner of the Word window on the status bar.

Adjust the slider right or left to make the text larger or

smaller, respectively.



To make the text appear on screen as close to actual size

as possible, click the 100% button on the status bar.

 Zooming doesn't affect how a document prints

— only how it looks on the screen.

For more specific zoom control, click the View tab and

use the commands found in the Zoom group.

 If the mouse has a wheel button, you can zoom

by pressing the Ctrl key on your keyboard and rolling

the wheel up or down. Rolling up zooms in; rolling

down zooms out.

Cajoling Word to help you

Like most Windows programs, a Help system is available in Word. You can

summon it by pressing the F1 key, which displays the Word Help window.

There you can type a topic, a command name, or even a question in the box

to search for help.

The F1 key also works any time you’re deep in the bowels of Word and doing

something specific. The Help information that's displayed tends to be

specific to whatever you’re doing in Word. Little buttons that look like

question marks also summon Word Help.

In the age of Google, Word also offers a Tell Me help box on the Ribbon, as

illustrated in Figure 1-2. Type a topic or question in the box and press the

Enter key to see a quick list of commands or suggestions, or to obtain online

help.

End Your Word-Processing

Day



It's the pinnacle of etiquette to know when and how to

excuse oneself. For example, the phrase “Well, I must be

off,” works a lot better than growling, “Something more

interesting must be happening anywhere else” —

especially at Thanksgiving. The good news for Word is

that’s completely acceptable to quit the program without

hurting its feelings.

Quitting Word
When you've finished word processing and you don't

expect to return to it anytime soon, you quit the Word

program. Click the X button in the upper-right corner of

the Word program window (refer to Figure 1-2).

The catch? You have to close each and every Word

document window that’s open before you can proclaim

that you’ve completely quit Word.

The other catch? Word won’t quit during that shameful

circumstance when you have unsaved documents. If so,

you’re prompted to save the document, as shown in

Figure 1-4. My advice is to click the Save button to save

your work; refer to Chapter 8 for specifics on saving

documents.

Figure 1-4: Better click that Save button!

If you click the Don’t Save button, your work isn’t saved

and Word quits. If you click the Cancel button, Word

doesn’t quit and you can continue working.



You don't have to quit Word just to start editing

another document. Refer to the next couple of sections

for helpful, timesaving information.

After quitting Word, you can continue to use Windows

by starting any other program, such as Spider Solitaire

or perhaps something more relaxing, like Call of Duty.

Closing a document without quitting

Word
You don't always have to quit Word. For example, if

you're merely stopping work on one document to work

on another, quitting Word is a waste of time. Instead, you

can close the document.

To close a document in Word and not quit, follow these

steps:

1. Click the File tab.

The File screen appears. Commands line the left side

of the screen, as shown in Figure 1-5.

2. Choose the Close command.

3. Save the document, if you’re prompted to do so.

The shame! Always save before closing. Tsk-tsk.



Figure 1-5: The File tab screen.

After it’s closed, you return to the main Word window,

although a document isn’t shown and many of the

command buttons are dimmed (unavailable). At this

point, you can start working on a new document or open

a document you previously saved.

Bottom line: There’s no point in quitting Word when all

you want to do is start editing a new document.

 There’s no urgency to close a document. I keep

mine open all day, even when I go off to do something

un-work related like play a game or see who’s being

obnoxious on Facebook. To return to your document at

any time, click its button on the Windows taskbar.



The keyboard shortcut for the Close command is

Ctrl+W. This command may seem weird, but it’s used

to close documents in many programs.

 To swiftly start a new, blank document in Word,

press Ctrl+N.

Setting Word aside
Don’t quit Word if you know that you will use it again

soon. In fact, I've been known to keep Word open and

running on my computer for weeks at a time. The secret

is to use the Minimize button, found in the upper-right

corner of the screen (refer to Figure 1-2).

Clicking the Minimize button shrinks the Word window

to a button on the taskbar. With the Word window out of

the way, you can do other things with your computer.

Then when you're ready to word-process again, click the

Word button on the taskbar to restore the Word window

to the screen.



Chapter 2

The Typing Chapter

In This Chapter

 Knowing the keyboard and mouse

 Using the spacebar

 Using the Enter key

 Observing the status bar

 Minding the space between pages

 Showing and hiding hidden characters

 Dealing with weird underlines

Word processing is about using a keyboard. It’s typing.

That’s the way computers were used for years, long

before the mouse and all the fancy graphics became

popular. Yep — ask a grizzled old-timer and you’ll hear

tales of ugly text screens and keyboard commands that

would tie your fingers in knots. Though things today

aren’t that bad, I highly recommend that you bone up on

your keyboard skills to get the most from your word-

processing duties.

Input Devices Galore

When you process words, you’re typing: clickity-clack-

clack. You use your fingers and one thumb to manipulate

the computer keyboard. It’s an important part of getting

text on a page, but also important is the mouse. No, you

don’t type with the mouse, but you’ll do some pointing

and clicking in additional to clickity-clack-clacking.



Using the PC keyboard
I’m sure you can easily recognize a computer keyboard,

but do you know the official terms that refer to its

various keys?

Relax: No one does.

Rather than look at all 100+ keys as a marauding hoard,

consider how the keys are clustered into groups, as

illustrated in Figure 2-1. To best use Word and

understand how the keyboard is referenced in this book,

it helps to know the general keyboard areas illustrated in

the figure.

Figure 2-1: A typical PC keyboard.

Of all the keys, a few play important roles in the word-

processing task. They are

Enter: Marked with the word Enter and sometimes a

cryptic, bent-arrow thing, this key is used to end a

paragraph of text. See the later section, “Pressing the

Enter key.”

Spacebar: The only key with no symbol, it inserts a

space between words and sentences. Yes, just one



space. See the later section, “Whacking the spacebar.”

Tab: This key inserts the tab character, which shoves

the next text you type over to the next tab stop. Using

this key properly is an art form. Chapter 12 is

dedicated to its use.

Backspace and Delete: Use these keys to back up

and erase text. Yes, erasing text isn’t a job always left

to the editor. Read more about these keys in Chapter

4.

Every character key you press on the keyboard produces

a character on the screen, on the blank part where you

write. Typing those character keys over and over is how

you write text on a word processor.

A laptop keyboard’s layout is different from the

desktop keyboard layout shown in Figure 2-1.

Primarily, laptop keyboards lack a numeric keypad.

The cursor keys are clustered tight around the

typewriter keys in unusual and creative patterns. The

function keys might be accessed by pressing special

key combinations.

Keys on the numeric keypad can be number keys or

cursor keys. The split personality is evident on each

key cap, which displays two symbols. When the Num

Lock key’s lamp is on, the keys generate numbers.

When the lamp is off, the keys serve as duplicate

cursor keys.

Cursor keys control the cursor, which is officially

known as the insertion pointer in Microsoft Word. The

cursor keys include the four arrow keys (up, down, left,

right), and also the keys Home, End, PgUp (or Page

Up), PgDn (or Page Down), Insert, and Delete.

Ctrl is pronounced “control.” It’s the control key.



The Delete key may also be labeled Del on the

keyboard.

The modifier keys, Shift, Ctrl, and Alt, work in

combination with other keys.

Understanding the mouse pointer
Though word processing is a keyboard thing, you will

eventually lift your hand from the keyboard to fondle the

computer mouse. The mouse is used to choose

commands, move around the document, and select text.

Specific information on these tasks is found throughout

this book. For now, it helps to understand how the mouse

pointer changes its look as you work in Word:

 For editing text, the mouse pointer becomes the I-

beam.

 For choosing items, the standard 11 o’clock mouse

pointer is used.

 For selecting lines of text, a 1 o’clock mouse pointer

is used.

The mouse pointer may change its appearance when

click-and-type mode is active: Teensy lines appear to the

left, right, and below the I-beam mouse pointer. Refer to

Chapter 32 for information on click-and-type.



 When you point the mouse at a command button

or any icon on the Word screen, you see a pop-up

information bubble. The text in the bubble describes

the command and perhaps offers information on how

the command is used.

Keyboard Dos and Don’ts

You don’t need to know how to type to use a word

processor. And if you don’t know how to type, see the

nearby sidebar, “Do I need to learn to type?,” although I

can tell you that the answer is “Yes.” It also helps to

know a few typing dos and don’ts that are particular to

word processing.

“Do I need to learn to type?”

No one needs to learn to type to use a word processor, but you do yourself a

favor when you learn. My advice is to get a computer program that teaches

you to type. I can recommend the Mavis Beacon Teaches Typing program,

even though I don’t get any money from her and none of her children

resemble me. I just like the name Mavis, I suppose.

Knowing how to type makes the word-processing chore a wee bit more

enjoyable.

Following the insertion pointer
Text you compose in Word appears at the insertion

pointer’s location. The insertion pointer looks like a

flashing vertical bar:

|



Characters appear before the insertion pointer, one at a

time. After a character appears, the insertion pointer

hops to the right, making room for more text.

The insertion pointer moves as you type, but its

location can be set to any location in the document.

Chapter 3 covers moving the insertion pointer around

in more detail.

 Some documentation refers to the insertion

pointer as a cursor. The mouse pointer might also be

referred to as a cursor. For clarity, this book refers to

the insertion pointer and mouse pointer without ever

using the term cursor.

Whacking the spacebar
Pressing the spacebar inserts a space character into the

text. Spaces are important between words and

sentences. Withoutthemreadingwouldbedifficult.

 The most important thing to remember about the

spacebar is that you need to whack it only once when

word processing. Only one space needs to appear

between words and after punctuation. That's it!

I'm serious! Back in the dark ages, typing instructors

directed students to use two spaces between

sentences. That extra space was necessary for

readability because typewriters used monospaced

characters. On a computer, however, the extra space

does nothing and potentially leads to formatting woes

down the road.


